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TRAINING IN REMOTE SENSING MODELS FOR 

MEASURING AND MAPPING FOREST 

CARBON WITH OPTICAL DATA 

BACKGROUND 

The Partnership for Land Use Science (Forest-PLUS) program is a five year initiative between USAID/India 

and Government of India (GOI). Forest-PLUS contributes to USAID/India’s Development Objective of 

accelerating India’s transition to a low emissions economy by encouraging REDD+ spread widely as an 

approach to forest management. Forest-PLUS demonstrates how improved conservation and management 

of forest ecosystems can reduce emissions from deforestation and forest degradation and sequester 

atmospheric carbon while at the same time enhancing biodiversity health, environmental services, forest-

based livelihoods and social uses. Forest-PLUS achieves these objectives by developing better tools, 

techniques, and methods for forest ecosystem management, scientific data acquisition and analysis, 

increasing individual and institutional capacities, and public awareness and environmental education. Forest-

PLUS demonstrates this integrated approach in four pilot landscapes that represent a diversity of India’s 

forest types, coordinating its efforts with the Ministry of Environment, Forest and Climate Change 
(MoEFCC), the REDD+ cell, State Forest Departments and the Green India Mission (GIM). 

TRAINING WORKSHOP CONCEPT 

To address the challenges in the forestry sector, particularly in REDD+ implementation, the design 

component of the program focuses on the US–India collaborative scientific and technical research and 

exchanges that explore methods and approaches to implement REDD+. This will be vital for India’s own 

programs and will further demonstrate India’s advances in science and technology to develop lessons that 

may be applied across the globe. Globally, there is a growing consensus that as a country moves toward 

full-scale REDD+ implementation, it will need to develop a REDD+ strategy and build capacity to  create 

measurable, reportable and verifiable (MRV) emission reductions, and MRV systems to support it. The 

tools, protocols, methods, and software for estimation of carbon in forests (carbon inventory) are needed 

for establishing forest carbon baselines and reference levels as well as MRV systems for measuring and 
monitoring carbon stock changes in forests. 

Establishing a high-quality GHG inventory is the first step to understanding opportunities to reduce 

emissions or increase sequestration. The GHG inventory must build on accepted international 

methodologies and standards to generate the activity data and emissions factors specific to India. This can 

involve collecting data and establishing management protocols and methods, as well as carbon calculation 

models and estimation tools. Institutional capacity building is important within forestry institutions at both 

the state and local levels where carbon and ecosystem service data will be collected and fed to the national 

level. Highly trained human resources are also required for the content of the National Forest Inventory 
(NFI) at the grassroots level. 

Forest-PLUS has developed four software models that use optical remote sensing satellite data for mapping 

forest carbon at the landscape level. This is training module that includes hands-on work with optical 

remote sensing data for end- to-end processing of data that produces Tier 2 and Tier 3 carbon maps.  
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Software Requirements: 

1. ERDAS Imagine (preferably version 9.3 or 2013) 

2. ArcMap (preferably version 10.0 or later) 

Data Requirements: 

 Landsat data (MSU/IORA) 

 Other optical data – e.g. LISS III or AWiFS (SFDs/IORA) 

 Forest cover data (SFDs/IORA) 

 Forest type data (SFDs/IORA) 

 Biomass/carbon data (SFDs/FSI/IORA) 

OBJECTIVES 

1. To build capacity of SFD technical staff in converting optical remote sensing data to 

2. Carbon maps at landscape scales using the Forest-PLUS developed software models. 

3. To build proficiency in running ERDAS Image software models for manipulating and analyzing 

optical remote sensing data and the ability to alter or update the models for processing additional 

optical data beyond Landsat. 

4. To build upon the community-of-practice started with the group who attended the  initial training 

and discussion of the models at FSI 19 – 20 June 2014 (Dehradun, India) 
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LIST OF MODELS, DATA SETS AND REFERENCE 

MATERIAL 

MODELS: All models are ERDAS Imagine “Graphic Models” with the .gmd file extension. More information 

on ERDAS Imagine graphical modeling can be found at: 
https://wiki.hexagongeospatial.com/index.php?title=Graphical_Modeling 

Table 1 is a list of the models provided for the training with a short description of each. 

Table 1: List of ERDAS imagine models 

 
Model Name Description 

**_dn_rads.gmd Calculates Radiance from “raw”, level 1G Digital Numbers 

 
**_rads_toaref.gmd 

Calculates Top-of-Atmosphere, At-Sensor Reflectance values from Radiance 
values 

 
toaref_ndvi.gmd 

Computes a normalized difference vegetation index (NDVI) using the red and nir 
bands of the Top-of-Atmosphere, At-Sensor Reflectance dataset 

 
toaref_msavi.gmd 

Computes a modified soil-adjusted vegetation index (MSAVI) using the red and 
nir bands of the Top-of-Atmosphere, At-Sensor Reflectance dataset 

 
toaref_evi.gmd 

Computes an enhanced vegetation index (EVI) using the blue, red and nir bands 
of the Top-of-Atmosphere, At-Sensor Reflectance dataset 

 

 
vi_fc.gmd 

Computes a vegetation continuous fields (forest fractional cover = fC) dataset 
with a spectral un-mixing algorithm (two end-members) and a VI data set as the 
input 

 
apply_mask.gmd 

Uses the F-MASK output file for masking cloud and cloud shadow areas to create 
a cloud-free data set for analyses 

 
Hillshade 

Creates a mask dataset separating hillshade pixels for separate processing in 
regions where topography and high relief is present 

 
vi_tier2carbon_strata.gmd 

Computes Tier 2 pixel-level carbon values using the fC dataset, mean carbon 
stock values, and a forest/land cover stratification dataset 

 
vi_tier2carbon.gmd 

Computes Tier 2 pixel-level carbon values using the fC dataset and mean carbon 
stock values 

 
vi_tier3carbon_strata.gmd 

Computes Tier 3 pixel-level carbon values using the fC dataset, plot level carbon 
stock values, and a forest/land cover stratification dataset 

 
vi_tier3carbon.gmd 

Computes Tier 2 pixel-level carbon values using the fC dataset and plot level 
carbon stock values 

** = Input sensor type: tm = Landsat TM, etm = Landsat ETM+, oli = Landsat OLI, l_III = LISS III, l_IV = LISS 

IV, awi = AWiFS 

We include the F-MASK software with a description of use with the models. F-MASK is used to identify cloud 

and cloud-shadow pixels and create a mask that can then be applied to “remove” these areas from the 

datasets. A cloud-free or near cloud-free data set can be created by mosaicking multiple, same area masked 

data sets to “fill” the masked areas. 

https://wiki.hexagongeospatial.com/index.php?title=Graphical_Modeling
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DATA SETS: Data sets include a) Optical Remote Sensing Satellite data, b) GIS data, and c) Forest Plot 
Inventory data. Tables 2, 3 and 4 provide a list of the data provided for the training. 

a) Optical Remote Sensing Satellite Data 
Table 2: Optical Remote Sensing Satellite Data by Forest-PLUS State and Sensor Type 

 
Sensor |Data 
Type 

 
Himachal Pradesh 

 
Karnataka 

 
Madhya Pradesh 

 
Sikkim 

Landsat TM LT51470381992227ISP00  LT51450442009291KHC00 LT51390412009041KHC00 

 

Landsat ETM+ 

 

LE71470382012146PFS00 

 

LE71460502013349SG100 

LE71450442012148PFS00 

LE71450442012356PFS00 

 

LE71390412013284SG100 

 

Landsat OLI 

 

LC81470382013268LGN00 

LC81460502013325LGN00 

LC81450512013126LGN01 

LC81450442013142LGN01 

LC81450452013142LGN01 

 

LC81390412013324LGN01 

AWiFS awh43f12nov07 awd43j02nov09 awf43l28oct10 awg45e08feb10 

 
 

 
LISS-III 

 
 
 

 
l3h43f0718oct08 

 
 
 

l3d43j0418nov11 

l3d43p0615dec09 

 
 
 

l3f43l1428oct09 

l3f43l1028oct09 

l3g45e1217dec08 

l3g45e1117dec08 

l3g45e0817dec08 

l3g45e0717dec08 

LISS-IV (IORA / SFDs) (IORA / SFDs) (IORA / SFDs) (IORA / SFDs) 

 

b) GIS Data 
Table 3: GIS data sets for training 

GIS Data Himachal Pradesh Karnataka Madhya Pradesh Sikkim 

Forest-PLUS Project Bdry.    

Forest Cover / Land cover   - 3 dates   

DEM (ASTER)    

Soil     

Other LU/LC Plots Biomass plots Biomass plots Biomass plots 

 

c) Forest Plot Inventory Data 
Table 4: Forest plot data 

Plot data Himachal Pradesh Karnataka Madhya Pradesh Sikkim 

Number of Plots NA 469 FSI; 64 F-PLUS 387 FSI; 4 F-PLUS 32 FSI 

 

  



- 6 - Manual: Training in Remote Sensing Models for Measuring and Mapping Forest Carbon 

 

 

RS MODELS FOR USING OPTICAL REMOTE 

SENSING SATELLITE DATA TO MAP 

FOREST CARBON 

PRE-PROCESSING MODELS 

 
Conversion of DNs to Top-of-Atmosphere at-Sensor Reflectance (TOA) 

The conversion of level 1R data (data that have had radiometric corrections applied during ground-station 

processing) to TOA reflectance is used to normalize data either for inter- comparison (in multi-temporal 

analyses) or for large area assessment that require multiple scenes mosaicked together. Conversion to 

TOA reflectance is a two-step process. The first model converts image digital numbers (DNs) to at-sensor 
radiance. The second model converts the at-sensor radiance to at-sensor TOA reflectance. 

Chander et al. (2009) report the calibration coefficients for Landsat MSS, TM and ETM+ data. The USGS 

has published on-line (http://landsat.usgs.gov/Landsat8_Using_Product.php) the conversion model for 

Landsat OLI data whose metadata files include the coefficients for conversion to TOA reflectance. Chander 

at al. (2013) and Pandya et al. (2013) provide information specific to AWiFS and LISS data for conversion to 
at-sensor TOA reflectance. These references are included with the data sets. 

Below are the equations and the ERDAS Imagine graphical models for 1) conversion of the DNs to at-

sensor radiance and 2) conversion of the at-sensor radiance to at-sensor TOA reflectance for Landsat 
ETM+ data. NB: Landsat 8 data use a DN  TOA model. 

1Conversion to at-sensor spectral radiance (Chander et al. 2009) 

 

http://landsat.usgs.gov/Landsat8_Using_Product.php
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Figure 1 Landsat ETM Convert DN to RAD 

 

For Band 1 the coefficients and equation are: ($n2_PROMPT_USER(1) * 0.778740) + (-6.98) Band 2 = 
($n2_PROMPT_USER(2) * 0.798819) + (-7.20) 

Band 3 = ($n2_PROMPT_USER(3) * 0.621654) + (-5.62) 

Band 4 = ($n2_PROMPT_USER(4) * 0.639764) + (-5.74) 

Band 5 = ($n2_PROMPT_USER(5) * 0.126220) + (-1.13) 

Band 7 = ($n2_PROMPT_USER(6) * 0.043898) + (-0.39) 
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2 Conversion to TOA reflectance (Chander et al. 2009) 

 
 

For Band 1 the coefficients and equation are: ((PI) * $n2_PROMPT_USER(1)) * ($n19_Float 

POWER (2)) /  ($n20_Custom_Float [0] * (COS ( (90 - $n21_Float) * (PI)/180 ) ) ) 

Band 2 = ((PI) * $n2_PROMPT_USER(2)) * ($n19_Float POWER (2)) / ($n20_Custom_Float  [1] * (COS ( 

(90 - $n21_Float) * (PI)/180 ) ) ) 

Band 3 = ((PI) * $n2_PROMPT_USER(3)) * ($n19_Float POWER (2)) / ($n20_Custom_Float  [2] * (COS ( 
(90 - $n21_Float) * (PI)/180 ) ) ) 

Figure 2 Landsat ETM Convert RAD to TOA REF 
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Band 4 = ((PI) * $n2_PROMPT_USER(4)) * ($n19_Float POWER (2)) / ($n20_Custom_Float  [3] * (COS ( 

(90 - $n21_Float) * (PI)/180 ) ) ) 

Band 5 = ((PI) * $n2_PROMPT_USER(5)) * ($n19_Float POWER (2)) / ($n20_Custom_Float  [4] * (COS ( 
(90 - $n21_Float) * (PI)/180 ) ) ) 

Band 7 = ((PI) * $n2_PROMPT_USER(6)) * ($n19_Float POWER (2)) / ($n20_Custom_Float  [5] * (COS ( 
(90 - $n21_Float) * (PI)/180 ) ) ) 

d (Earth-Sun distance for this scene acquisition date) = 1.000910000000 Sun Elevation Angle = 
55.179633690000 

ESUN Values for Bands: 1 = 1997, 2 = 1812, 3 = 1533, 4 = 1039, 5 = 230.8, 7 = 84.9 

 
Figure 3 

VEGETATION INDEX MODELS (VIS) 

 
Three vegetation index models are provided as part of the training: normalized difference vegetation index 

(NDVI), modified soil-adjusted vegetation 2 index (MSAVI2), and enhanced vegetation index (EVI).  
Equations for each vegetation index are shown below 

3 

  
4 
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5 

 
 

The Normalized Difference Vegetation Index (NDVI) is an index of plant “greenness” or 

photosynthetic activity, and is one of the most commonly used vegetation indices. Vegetation indices are 

based on the observation that different surfaces reflect different types of light differently. 

Photosynthetically active vegetation, in particular, absorbs most of the red light that hits it while reflecting 

much of the near infrared light. Vegetation that is dead or stressed reflects more red light and less near 

infrared light. Likewise, non-vegetated surfaces have a much more even reflectance across the light 

spectrum. 

 

By taking the ratio of red and near infrared bands from a remotely-sensed image, an index of vegetation 

“greenness” can be defined. The Normalized Difference Vegetation Index (NDVI) is probably the most 

common of these ratio indices for vegetation. NDVI is calculated on a per-pixel basis as the normalized 

difference between the red and near infrared bands from an image where NIR is the near infrared band 

value for a cell and RED is the red band value for the cell. NDVI can be calculated for any image that has a 

red and a near infrared band. The biophysical interpretation of NDVI is the fraction of absorbed 

photosynthetically active radiation. 

 
Many factors affect NDVI values like plant photosynthetic activity, total plant cover, biomass, plant and soil 

moisture, and plant stress. Because of this, NDVI is correlated with many ecosystem attributes that are of 

interest to researchers and managers (e.g., net primary productivity, canopy cover, bare ground cover). 

Also, because it is a ratio of two bands, NDVI helps compensate for differences both in illumination within 

an image due to slope and aspect, and differences between images due things like time of day or season 

when the images were acquired. Thus, vegetation indices like NDVI make it possible to compare images 

over time to look for ecologically significant changes. 

 
The modified soil-adjusted vegetation index (MSAVI) and its later revision, MSAVI2, are soil adjusted 

vegetation indices that seek to address some of the limitation of NDVI when applied to areas with a high 

degree of exposed soil surface. The problem with the original soil-adjusted vegetation index (SAVI) is that 

it required specifying the soil-brightness correction factor (L) through trial-and-error based on the amount 

of vegetation in the study area. Not only did this lead to the majority of people just using the default L 

value of 0.5, but it also created a circular logic problem of needing to know what the vegetation 

amount/cover was before you could apply SAVI which was supposed to give you  information on how 

much vegetation there was. Qi et al. (1994a) developed the MSAVI, and later the MSAVI2 (Qi et al. 1994b) 

to more reliably and simply calculate a soil brightness correction factor. 

 
The enhanced vegetation index (EVI) was developed as an alternative vegetation index to address 

some of the limitations of the NDVI. The EVI was specifically developed to: 

 be more sensitive to changes in areas having high biomass (a serious shortcoming of NDVI),

 reduce the influence of atmospheric conditions on vegetation index values, and

 correct for canopy background signals.

 
EVI tends to be more sensitive to plant canopy differences like leaf area index (LAI), canopy structure, and 

plant phenology and stress than does NDVI which generally responds just to the amount of chlorophyll 

present. 
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Figure 4 TOA Reflectance to NDVI 

 

The NDVI Equation = EITHER 0 IF ( $n12_memory + $n13_memory == 0 ) OR ( ($n13_memory - 
$n12_memory) / ($n12_memory + $n13_memory) ) OTHERWISE 

 

Where 

$n12_memory = RED Band 

$n13_memory – NIR Band 
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Figure 5 AWiFS and LISS-III to MSAVI-2 

 

The MSAVI2 Model is in four separate equations parts: 1.   ((2 * $n5_temp) + 1) 

2.   ( ( (2 * $n5_temp) + 1 )  POWER 2) - 8 * ($n5_temp - $n4_temp) 

SQRT ( $n7_memory ) 

($n10_memory - $n11_memory) / 2 

 

Where 

$n5_temp = RED Band 

$n4_temp = NIR Band 

$n7_memory = solution of #2 

$n10_memory = solution of #1 
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$n11_memory = solution of #3 

 
Figure 6 TOA Reflectance to EVI 

 

The EVI Model is in three separate equation parts 

1.   $n1_PROMPT_USER(4) + (6 * $n1_PROMPT_USER(3)) - (7.5 * 

$n1_PROMPT_USER(1)) + 1 

$n1_PROMPT_USER(4) - $n1_PROMPT_USER(3) 

EITHER 0 IF ( $n7_memory == 0 ) OR (2.5 * ($n3_memory/$n7_memory) ) OTHERWISE 

 

And a conditional statement to scale the data between -1 and 1: 

CONDITIONAL  {  ($n9_memory  <  -1)  -1,  ($n9_memory  >  1)  1,  ($n9_memory  >=  -1 AND 

$n9_memory <= 1) $n9_memory } 
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Where 

$n1_PROMPT_USER(4) = NIR Band n1_PROMPT_USER(3) = RED Band 

$n1_PROMPT_USER(1) = BLUE Band 

$n7_memory = solution to #1 

$n3_memory = solution to #2 

 
Figure 7 

VEGETATION CONTINUOUS FIELDS | FOREST FRACTIONAL COVER (FC) MODEL 

 
Fractional cover refers to estimating the proportion of an area that is covered by each member of a 

predefined set vegetation or land cover types. For mapping fractional cover, the proportions of the 

different classes should sum to one. In terms of remote sensing, the area being considered is generally a 

pixel (although fractional cover estimation can be applied to object-based image analysis), and the 

estimation of fractional cover is considered a type of "spectral un-mixing" or sub-pixel classification. 

There are many different techniques for estimating vegetation fractional cover from remotely-sensed data. 

Fernandes et al. (2004) and Scanlon et al. (2002) described the following sub-pixel mapping techniques 
applied to estimating fractional cover: 

 Spectral Un-mixing Models - spectral un-mixing is based on the theory that the observed 

reflectance of a pixel (or object-t) is a function of the proportion of the different cover types 

within the pixel as well as other factors like the relative brightness of the cover types. If spectral 

signatures are known from “pure” representations of each cover type, then the proportion of the 

cover types in the pixel can be figured out.

2. Conventional “Hard” Classification - “Hard” classes are rigidly defined in terms of their 

composition and cover, and are generally found in land cover maps. For example, a land cover map 
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may have a Douglas-fir class, a ponderosa pine class, and a mixed Douglas-fir/ponderosa pine class. 

The implicit assumption here is that the “pure” classes have very little cover of the other 

species, and that the mixed class has roughly equal proportions of both. With such an approach, 

techniques like Supervised Classification or Unsupervised Classification are employed to try to 

directly classify or map the “hard” classes. 

 Linear Modeling - linear modeling approaches attempt to relate reflectance data recorded by a 

sensor to field measurements of fractional cover using linear regression techniques. Such 

approaches may correlate field-measured fractional cover with sensor reflectance bands, or to 

vegetation indices like NDVI.

 Artificial Neural Networks (ANN) - ANN are networks of simple processes, decisions, or 

algorithms applied to data that are good at analyzing data from non-linear and non-parametric 

systems. With remote sensing, ANN has typically been used for “hard” classifications, but it has 

also been used to derive fractional cover (e.g., Foody et al. 1996, Moody et al. 1996).

 Physical Models - Physical models use principles of how light energy is absorbed or reflected 

from different surfaces to estimate fractional cover. Biophysical models incorporate parameters 

related to how light interacts with processes like photosynthesis, evapotranspiration, stress, and 

decay of plant material. Geometric- optical models consider how the spectral reflectance of 

different surfaces interact to influence the values recorded by a sensor. Physical models require 

making assumptions of how systems reflect light and estimating or measuring model parameters to 

achieve accurate results. Many physical models require estimation of a bi-directional reflectance 

distribution function - a function that defines how much light is reflected from a surface depending 

not only on the surface's reflectance properties, but also on the angles of the incoming and 

reflected light. Because of this, physical model approaches to estimation fractional cover have, to 

date, been applied mostly to fine-scale images over small areas.
 

The method deployed for Forest-PLUS is the Spectral Un-mixing Model. See Matricardi et al (2010) 

for the application of a forest fractional cover model based on spectral two end- members (Soil and 
Closed Canopy Forest) in the Brazilian Amazon. 

The two end-member linear mixture model equation is: 

6 

 

 

Where: 

fc=green fractional percentage,

VI=vegetation index value,

VI canopy=vegetation index value of the tree green canopy, and

VI open=vegetation index value of senescent open areas.
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The ERDAS Imagine graphical model is shown below. 

 
Figure 8 ERDAS spectral unmixing model 

 

End-members are identified using Area-of-Interest (AOI) analyses linking a user-defined optimal data 

stretch for a false-color composite (RGB) view and a VI data set for the same area. Users identify 5 – 10 

AOIs for soil pixels and another set for 100% closed canopy forest pixels and computes the mean of the VI 
pixel subsets. These values become the end- member inputs to the model. 
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Figure 9 Selected AOIs in 100% Closed Canopy Forest Area 

 

Figure 10 Histogram of AOI pixels from MSAVI Dataset; Mean value = 0.3606
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Figure 11 

TIER 2 CARBON MAPPING MODELS 

 
There are two versions of the Tier 2 forest carbon mapping model: 

1. Integration of fC data with a stratification data and mean carbon stock values for each strata 

2. Integration of fC data with mean carbon stock values in homogenous forest landscapes with no land 

cover based stratification 

The basis for the forest carbon mapping relies on the association of fC mapping with forest biophysical 

attributes such as forest canopy openness and biomass. Higher fC values are forest areas of higher biomass 
(carbon) and lower fC values are forest areas with lower biomass (carbon). 

When using the model that includes a stratification data set, mean carbon values for each stratum must be 

calculated. The FSI publication, Carbon Stocks in India’s Forest, reports Tier 2 carbon stocks by Forest Type, 

Density Class and Region (http://www.fsi.nic.in/details.php?pgID=sb_15). An alternative method is to calculate 
the mean carbon stock for each stratum from a series of sample plots. 

The second model does not require a stratification data set and is appropriate for mapping carbon in areas with 

fairly homogenous forest cover. 

The ERDAS Imagine graphical models for Tier 2 Forest Carbon Mapping are shown below.

http://www.fsi.nic.in/details.php?pgID=sb_15
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Figure 12No-Strata Tier 2 Forest Carbon Model 

  

A level slice is used to separate forest from non-forest pixels.  This value might range from 20 – 45 fC. 

 
Mean fC values are calculated for the “forest” fC pixels. 

 
Mean Carbon values are from literature or calculated from plots. 

 
The model equation for all “forest” pixels is = ($n18_memory / $n29_Float) * $n28_Float Where 

$n18_memory = “forest” pixel fC value 

$n28_Float = Mean Carbon value 

$n29_Float = Mean fC value for all “forest” pixels 
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Figure 13 Forest Carbon Model with Strata 

 

A level slice can be used to separate forest from non-forest pixels. This value might range from 20 – 45 fC. 

However, more likely the strata dataset will include non-forest areas. Therefore this equation can be set 
to 0. 

Mean fC values are calculated for all fC pixels by strata. 

Mean Carbon values are from literature or calculated from plots by strata. 

The model equation for all pixels is =  $n12_Custom_Float[1]) *    .09, ($n34_PROMPT_USER 

== 2004) (($n18_memory  * $n11_Custom_Float[2]) /

 $n12_Custom_Float[2]), ($n34_PROMPT_USER == 2005)  (($n18_memory

 * $n11_Custom_Float[3]) / 

$n12_Custom_Float[3])      ,      ($n34_PROMPT_USER      ==      20041)      (($n18_memory    * 

$n11_Custom_Float[4])   /   $n12_Custom_Float[4])   , ($n34_PROMPT_USER  ==   20051) 
(($n18_memory * $n11_Custom_Float[5]) / $n12_Custom_Float[5]) } 

Where 

$n11_Custom_Float = Mean Carbon value by strata 
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$n12_Custom_Float = Mean fC value by strata 

$n34_PROMPT_USER = Strata class code 

 
Figure 14 

TIER 3 CARBON MAPPING MODELS 

 
There are two versions of the Tier 3 forest carbon mapping model: 

1. Integration of fC data with a stratification data and a derived calibration model for each stratum 

2. Integration of fC data with a derived calibration model in homogenous forest landscapes with no 

land cover based stratification 

 
The basis for the forest carbon mapping relies on the association of fC mapping with forest biophysical 

attributes such as forest canopy openness and biomass. Higher fC values are forest areas of higher biomass 

(carbon) and lower fC values are forest areas with lower biomass (carbon). 

 
When using the model that includes a stratification data set, a calibration model is developed for each 

stratum. The calibration model is developed using the pair-wise values of forest plot biomass and the co-

located fC pixels in geographic terms. These pairs  are input  to  either  an  OLS  regression  or  a  simple  

relationship  (linear  or  non-linear). The resulting equation is used in the ERDAS .gmd model as a 

calibration algorithm that computes forest carbon values from the fC value and specific calibration 
coefficients. 

The second model does not require a stratification data set and is appropriate for mapping carbon in areas 
with fairly homogenous forest cover. 

The ERDAS Imagine graphical models for Tier 3 Forest Carbon Mapping are shown below.  
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Figure 15 No-Strata Tier 3 Forest Carbon Model 

A level slice is used to separate forest from non-forest pixels.  This value might range from 20 – 45 fC. 

The model equation is = (SLOPE * $n7_memory) - INTERCEPT Where 

$n7_memory = “forest” pixel fC value SLOPE = value derived from OLS regression 

INTERCEPT = value derived from OLS regression 
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Figure 16 Tier 3 Forest Carbon Model with Strata 

 
A level slice can be used to separate forest from non-forest pixels. This value might range from 20 – 45 fC. 

However, more likely the strata dataset will include non-forest areas. Therefore this equation can be set 
to 0. 

The model equation for all pixels is = CONDITIONAL { ($n34_PROMPT_USER== 1) 

($n18_memory*$n11_Custom_Float[0]) + $n12_Custom_Float[0], ($n34_PROMPT_USER == 

2) ($n18_memory*$n11_Custom_Float[1]) + $n12_Custom_Float[1],  ($n34_PROMPT_USER 

== 3) ($n18_memory*$n11_Custom_Float[2]) + $n12_Custom_Float[2], ($n34_PROMPT_USER
 == 4) ($n18_memory*$n11_Custom_Float[3]) + 

$n12_Custom_Float[3], ($n34_PROMPT_USER == 5) ($n18_memory*$n11_Custom_Float[4]) + 
$n12_Custom_Float[4], ($n34_PROMPT_USER == 
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($n18_memory*$n11_Custom_Float[5]) + $n12_Custom_Float[5] } 

Where 

$n11_Custom_Float = Slope value derived from OLS by strata 

$n12_Custom_Float = Intercept value derived from OLS by strata 

$n18_memory = “Forest” pixel if using level slice 

$n34_PROMPT_USER = Strata class code 
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FIELD DATA COLLECTION FOR 

INTEGRATION WITH OPTICAL REMOTE 

SENSING SATELLITE DATA TO MAP 

FOREST CARBON 

Field data collection is integral to carbon mapping with optical remote sensing data. Landscape stratification 

using satellite data and other geographic data sets such as topography, soil, land use and the like are 

validated through field data collection methods. Forest plot inventory data are required for both Tier 2 
and Tier 3 forest carbon mapping using optical satellite data. 

LAND USE AND LAND COVER DATA COLLECTION 

Protocol: Post-stratification validation 

Stratification maps should be developed using the most advanced data processing methods available to the 

technical staff. The most basic method would include unsupervised classification of remote sensing satellite 

data. More elaborate methods might include a hybrid approach that includes object detection with spectral 

classifiers and additional geographic parameters such as elevation and soil type. At a minimum, the 

stratification should include Forest and Non-forest level 1 classes. A level 2 classification might include 
forest type and or canopy classes. 

Steps: 

1. Generate random or stratified sample points in a GIS for all classes of data in the stratification 

map. 

2. Field visit 70 - 80% of the sample points 

3. Record data 

a. GPS location | Point Number 

b. Date and time 

c. Data collection team 

d. Land cover class 

e. Land use class 

f. Land cover history 

g. Land use history 

h. Climate type 

i. Soil 

j. Slope / Aspect (if in high relief area) 

k. If forest cover 

l. Type: evergreen, deciduous, mixed 

m. Condition: primary, secondary, degraded 

n. % Canopy Openness 

o. List of tree species 

p. Presence of shrubs 

q. Plantation or natural forest 

r. Digital photos 
Tools: GPS, Data logger/record sheet, Laptop with satellite data and GIS or RS Software, digital camera 

FOREST PLOT INVENTORY DATA COLLECTION 
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Protocol: Post-stratification forest plot inventory 

Stratification maps should be developed using the most advanced data processing methods available to the 

technical staff. The most basic method would include unsupervised classification of remote sensing satellite 

data. More elaborate methods might include a hybrid approach that includes object detection with spectral 

classifiers and additional geographic parameters such as elevation and soil type. At a minimum, the 

stratification should include Forest and Non-forest level 1 classes. A level 2 classification might include 
forest type and or canopy classes. 

Steps: 

1. Generate random or stratified sample points in a GIS for all classes of data in the stratification 

map 

a. Use the Forest-PLUS Sample Design Tool to identify the number of plots required to 

meet specific error/confidence levels. 

2. Use the FSI Manual of Instruction for Field Inventory for NFI Plots or follow steps 3 - 11 

3. Navigate to field GPS point in the field – establish this as a center point 

4. Mark of plot corners using a 45
o  

angles (45
o
,135

o
, 225

o
, and 315

o
) measured out 22.36 

meters from the center point location 

5. For all living trees greater than 10 cm DBH measure and record 

a. DBH (to the 100
th 

cm) 

b. Height (to the 10
th 

m) for all trees greater than 10 cm DBH 

c. Species 

6. Count of all trees less than 10 cm DBH 

7. Count of all shrubs 

a. Small > 1 m 

b. Medium 1 < 3 m 

c. Tall > 3 m 

8. Count of standing and down deadwood 

a. Small > 10 cm DBH 

b. Large < 10 cm DBH 

9. Measure % Canopy Openness with a densitometer or digital fish-eye lens 

a. Center point 

b. All four corner points 

c. Additional 10 m in cardinal direction (NW, NE, SW, SE) from corner points 

10. Record data 

a. Plot ID 

b. Strata Name 

c. Date and time 

d. Data collection team 

e. Land cover class 

f. Land use class 

g. Land cover history 
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h. Land use history 

i. Climate type 

j. Soil 

k. Slope / Aspect (if in high relief area) 

l. If forest cover 

m. Type: evergreen, deciduous, mixed 

n. Condition: primary, secondary, degraded 

o. % Canopy Openness 

p. List of tree species 

q. Presence of shrubs 

r. Plantation or natural forest 

11. Digital photos 

Tools: GPS, Data logger/record sheet, DBH tape, 50-m tape, laser hypsometer or other tree height 

measurement tool, compass, flagging tape, forester’s marking chalk, tree identification resource, 

densitometer or other forest canopy measurement tool (fish-eye lens), digital camera; If measuring SOC 

need soil auger, plastic bags, marker; If measuring litter need 1-m square frame, field scale, plastic bags, 

marker. 
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REFERENCE MATERIAL:  

The training packet includes a number of scientific publications and general reference documents as 

background material and support for analyzing optical remote sensing satellite data to forest fractional 

cover and biomass (carbon). 

Chander et al. (2013). ResourceSat – 2 AWiFS Preliminary Data Quality Assessment. JACIE Workshop, 
April 16 – 18, 2013. 

Chander, G., Markham, B. L., & Helder, D. L. (2009). Summary of current radiometric calibration 

coefficients for Landsat MSS, TM, ETM+, and EO-1 ALI sensors. Remote sensing of environment, 113(5), 

893-903.Fernandes, R., Fraser, R., Latifovic, R., Cihlar, J., Beaubien, J., & Du, Y. (2004). Approaches to 

fractional land cover and continuous field mapping: A comparative assessment over the BOREAS study 
region. Remote Sensing of Environment, 89(2), 234-251. 

Matricardi, E. A., Skole, D. L., Pedlowski, M. A., Chomentowski, W., & Fernandes, L. C.  (2010). 

Assessment of tropical forest degradation by selective logging and fire using Landsat imagery. Remote 

Sensing of Environment, 114(5), 1117-1129. 

Pandya, M. R., Murali, K. R., & Kirankumar, A. S. (2013). Quantification and comparison of spectral 

characteristics of sensors on board Resourcesat-1 and Resourcesat-2 satellites. Remote Sensing Letters, 
4(3), 306-314. 

Scanlon, T. M., Albertson, J. D., Caylor, K. K., & Williams, C. A. (2002). Determining land surface fractional 

cover from NDVI and rainfall time series for a savanna ecosystem. Remote Sensing of Environment, 82(2), 

376-388. 

USGS (ND). Using the USGS Landsat 8 Product. http://landsat.usgs.gov/Landsat8_Using_Product.php 

USGS (ND). How do Landsat 8 band combinations differ from Landsat 7 or Landsat 5 satellite data? 
https://landsat.usgs.gov/L8_band_combos.php 

http://landsat.usgs.gov/Landsat8_Using_Product.php
https://landsat.usgs.gov/L8_band_combos.php


- 29 - Manual: Training in Remote Sensing Models for Measuring and Mapping Forest Carbon 

 

 

APPENDIX A 

STRUCTURE OF FILES ON 32 GB USB FLASH DRIVES 

 
Four Top-Level Folders 

3. Additional_Files 

4. Image_processing 

5. Reference_files 

6. Study_areas 

 

Top Level Files 

7. Agenda - RS Optical WorkshopdDecember 2014-Seven_Day_Agenda_v3 

8. FPP-MSU-IORA-20140714.Four_Landscape_ProjectAreas_v2.0 

9. RS_Forest_Carbon_Training_Manual_Dec2014_f 

 
Additional_Files Folder 

10. Endmember_Signature_Library.xlsx 

11. FC_Biomass_regression.xlsx 

12. Indiapoliticalboundary.rar (Compressed shapefile for India) 

13. RS_data_catalogue.xlsx 

 
Image_processing Folder 

 ERDAS_Models 

o 23 ERDAS .gmd Models 

 fC_and_Carbon_analysis 

o Instructions for extracting pairwise data of fC and Carbon using ArcMap 

 fMask 

o Fmask executable program 

o Instructions for using fMask 

o Original_instructions_and_journal_article (folder) 

 Hillshade 

o Instructions for creating a Terrain Shadow Mask using ASTER GDEM data 

 FC_Biomass_regression.xlsx (Example of MP and Karnataka Tier 3 Equations) 

 
Reference_files Folder 

 Various publications 

 
Study_areas Folder 

 HP 

o GIS 

o F-PLUS project boundary shapfiles 

o 2013 LU/LC GPS data points 

o Forest cover classification 2009 
Plot data 
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Plot summary from November 2013 site visit in Himachal Pradesh.xlsx 

 Sample 

o ASTER  DEM 

o AWiFS  Rads, Stack, VI 

o Landsat_8  Fractional_Cover, Rads, Stack, Toa_ref, VI 

o LISS-III  Rads, Stack, VI 

 Unprocessed_data 

o Compressed Landsat OLI, ETM+, TM, AWiFS, and LISS-III Data 
Karnataka 

 F-PLUS project boundary shapefile 

o Four (4) Biomass Plots – Forest-PLUS April 2013 (shapefile) 

o FSI Plots – 469 plots 

o Land use/Land Cover data for 2001, 2006, 2012 (.img files 

 Plot_data 

o Shimoga folder with DMS ready data 2014 (64 plots) 

o Plot_Data_Shimoga_April_2014 (4 plots) 

o Shimoga _FSI.xlsx 

 Sample 

o AWiFS  Rads, Stack, VI 

o Landsat_8  Carbon, Fractional_Cover, Stack, Toa_ref, VI 

o LISS-III  Rads, Stack, VI 

 Unprocessed_data 

o Compressed Landsat OLI, ETM+, TM, AWiFS, and LISS-III Data 
MP 

 Forest Cover.zip 

 Forest Stock.zip 

 Forest Type.zip 

 F-PLUS project boundary shapefile 

 Four (4) Biomass Plots – Forest-PLUS April 2013 (shapefile) 

 FSI Plots for Harda – 112 plots 

 FSI Plots for Hoshangabad – 275 plots 

 A sample test strata for running the carbon with strata model 

 Plot_data 

o Harda_FSI.xlsx 

o Hoshangabad_FSI.xlsx 

o Hoshangabad Plot Data_April2013 (folder) 

 Sample 

o  

o Fractional_Cover, Rads, Stack, Toa_ref, VI 

o LISS-  

 Unprocessed_data 

o Compressed Landsat OLI, ETM+, TM, AWiFS, and LISS-III Data 

Sikkim 

 F-PLUS project boundary shapefile 

 FSI Plots – 32 plots 

 Plot_data 

 

East_Sikkim_FSI.xlsx 
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 Sample 

o ASTER  DEM, Hilshade, Mask 

o AWiFS  Rads, Stack, VI 

o Landsat_8  Fractional_Cover, Masked_data, Rads, Stack, Toa_ref, VI 

o LISS-III  Rads, Stack, VI 

 Unprocessed_data 

o Compressed Landsat OLI, ETM+, TM, AWiFS, and LISS-III Data 
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APPENDIX 2 ADDITIONAL PROCESSING 

GUIDANCE DOCUMENTS 

1. To Create a Terrain Shadow Mask with ASTER GDEM 

2. Pairwise extraction statistical reporting 

3. Using fMask 

 

TO CREATE A TERRAIN SHADOW MASK WITH ASTER GDEM-2 

 

ASTER GDEM-2 data is provided for Sikkim and Himachal Pradesh in their respective scene folders. 

 

1. Mosaic DEMs (if necessary) 

a. In ArcMap, ArcToolbox -> Data Management Tools -> Raster -> Raster Dataset -> 

Mosaic To New Raster. 

b. Select DEM .tif files as input rasters, specify output location, specify the new raster 

dataset name with file extension (.tif), DO NOT input a spatial reference, pixel type 

should be changed to 32-Bit-Signed, no cellsize, Number of Bands should be 1, all other 

parameters can be left as default values. 

c. Locate new raster dataset in ArcCatalogue. Specify the correct UTM Zone projection, 

Spheroid and Datum WGS 84. 

2. Generate Hillshade Raster based on sun-illumination of a Landsat Image 

a. In ArcMap, ArcToolbox -> Spatial Analyst Tools -> Surface -> Hillshade 

b. Select the DEM as the input raster 

c. Specify output raster 

d. Enter the Azimuth and Altitude (sun elevation) values from the Landsat metadata file, 

other parameters can be left alone. 

3. Generate Mask 

a. Determine a threshold value for sun-illumination/terrain shadow, or just use the median 

value of 127 (0-254 range). Lower values should represent lower sun illumination. 

b. In ArcMap, ArcToolbox -> Spatial Analyst Tools -> Map Algebra -> Raster Calculator 

c. Formula: “RASTER_HILLSHADE” < 127 

d. Specify output raster 

4. Prepare the mask for use in ERDAS 

a. In ERDAS, Manage Data -> Import Data 

b. Select TIF as Format, and select the mask created in ArcMap as the Input File 

c. Specify the Output File, and make sure the file extension is .img 

d. Click OK, In the Import TIFF window select Import Options 

e. Output data type should be unsigned 1-bit, all other parameters can be default 

f. Click OK to import 

g. Once finished importing, go to Manage Data -> Edit Image Metadata 

h. Navigate to the .img file and change raster type to thematic, select compute statistics and 

compute pyramid layers.  Click OK. 

i. Use the .img file as one of the inputs to the model 

”4_landsat_terrain_shadow_mask.gmd” – this will remove the shadowed regions from 

the image. To remove the illuminated regions, change the value in the conditional 

statement of the model from 1 to 0. 

PAIR-WISE EXTRACTION OF BIOMASS PLOT POINTS AND FC 
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The objective here is to determine fractional cover values associated with ground-based plot biomass 

measurements. This is accomplished in ArcMap using the following steps: 

In ArcMap: Add the plot biomass point shapefile and the raster fractional cover data to ArcMap. 

14. Extract values by using ArcToolbox -> Spatial Analyst Tools -> Extraction -> Extract Multi Values 

to Points. This tool creates a new field in the attribute table of the input point shapefile, and 

populates it with the raster values that each point matches spatially. 

o Input point features should be the point shapefile containing biomass plots 

o Input raster is the fractional cover dataset 

o Select an output field name (for example, fC_value) 

o Check the box for bilinear interpolation. This negates the need to perform a low pass filter 

algorithm on the raster dataset prior to processing. What this means is that the goal is to 

extract as close a representative fC value for that particular plot point as possible, so 

taking the average fC value at that plot based on the neighboring pixels negates the 

possibility that the plot itself may fall within more than one pixel. 

15. Click OK to run 
The extracted values can be observed by opening the attribute table of the point shapefile 

Regression analysis can be carried out by copying the attribute table values to an excel spreadsheet, and 

comparing the plot biomass value with its corresponding fC value 

STATISTICS REPORTING FOR FRACTIONAL COVER 

 
The objective is to determine the mean fractional cover value for each individual forest-type or land- cover 

strata. This can be accomplished similarly in ERDAS or ArcMap, but the preferred method is ArcMap. 

16. In ArcMap: Add the fractional cover raster dataset and the strata/forest-type dataset (this can be 

either a thematic raster or a shapefile). 

17. Go to ArcToolbox -> Spatial Analyst Tools -> Zonal -> Zonal Statistics as Table (one could also 

use Zonal Statistics, but this is unnecessary for our objective.) 

18. Input raster or feature zone data is the strata thematic raster, or the strata shapefile 

19. Zone field is the attribute table field which differentiates between the contained strata 

20. Input value raster is the fractional cover raster dataset 

21. Specify the output table location and name 

22. Select MEAN for the statistics, and select to ignore NoData in calculations 

23. Click OK to run 

The output table can be opened with MS Excel for extrapolating the mean fC values as inputs into the 
carbon model “6_fc_to_carbon_mean_nostrata.gmd” or “6_fc_to_carbon_mean_withstrata.gmd” 

USING FMASK 

The software required to run the algorithm can be downloaded at https://code.google.com/p/fmask/ 

The most recent version is 3.2 and works for Landsat 4, 5, 7, and 8. 

1. Run the install package (Fmask_pkg.exe). Once completed, create a directory to contain the 

executable file fmask.exe (for example, C:/Tools, or something similar), and move the fmask.exe to 

this new folder. 

2. In order to run properly, the scene data must be contained in a unique folder (one folder per 

scene, and I recommend using the scene ID for the folder name). The files that must be contained 

in the scene folder are the original uncompressed raw bands (SceneID_bX.tif, where X is the band 

number) and the scene metadata file (SceneID_MTL.txt). Also, Landsat 8 scenes should contain the 

SceneID_BQA.tif file; in general it is a good idea to just include all of the original files that are 

https://code.google.com/p/fmask/
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contained in the raw compressed folder. 

3. *** Note that additional files such as pyramid layers can cause errors when running the fmask 

algorithm, so it is recommended to remove any auxiliary files that are created by ERDAS or 

ArcGIS prior to running the algorithm*** 

4. Once the fmask package has been installed and the scene folder contains the proper files as noted 

above, the algorithm can be run by opening the Windows Command Prompt (Start Menu 

 Search -> cmd.exe) 

5. cd into the folder containing the scene’s data. 

6. For example in command prompt type: cd C:/data/LC81470382013268LGN00 

7. Run fmask.exe by using the directory that was created above. For example C:/Tools/fmask.exe 

8. This will begin the algorithm using default parameters. 

9. Parameter values for the buffer around detected cloud, cloud-shadow, and snow pixels can be 

adjusted. The default values are 3, 3, and 0 respectively. These values are sufficient for masking out 

cloud and cloud-shadow edges that are most likely contaminated but aren’t caught by the 

algorithm, so they don’t have to be changed. 

10. The other parameter that can be changed is the cloud probability threshold. The default value for 

this is 22.5 (values range from 0-100). This value has been shown to be sufficient, but decreasing it 

can increase the algorithm’s sensitivity to cloud and cloud shadow detection, but may also increase 

processing time. 

11. The parameter values must be entered in order of cloud buffer, shadow buffer, snow buffer, and 

cloud threshold. 

12. Therefore, C:/Tools/fmask.exe is sufficient to run the algorithm, but including the parameters 

would look like this for example:  C:/Tools/fmask.exe 1 1 0 15 

13. Running this uses values of cloud and cloud-shadow buffers of 1 pixel each, 0 pixel buffer for snow, 

and a cloud probability threshold of 15. 

14. Processing begins when this line is entered, and depending on the cloudiness or presence of snow, 

the processing time can vary from 5 minutes for relatively clear scenes to over an hour for the 

most contaminated scenes. Also note that processing time for Landsat 8 scenes is generally longer 

than for the other Landsat platforms due to a higher bit-depth. The algorithm is very taxing on 

system resources so it is recommended to close all other programs prior to running, and to allow 

the algorithm to finish before using the computer for anything else. It is possible to experience a 

“crash” in which fmask fails due to a memory issue, usually this occurs when trying to process 

Landsat 8 scenes with excessive clouds. If this happens, the windows command prompt will display 

a memory error. Rebooting the computer and running again with lower buffer values and a higher 

cloud threshold probability is the only way I know of to try and get around this.  The scene itself 

might also be too cloudy to be useable, and this is especially true for Landsat 8 scenes that have 

excessive clouds in the cirrus band 9. 

15. Scenes must be processed one at a time (multiple scene data cannot be contained in the same 

folder, or an error will occur!). 

16. ***An alternative way to run fmask on a scene is to copy the fmask.exe into the folder containing 

the raw data. Double-clicking the executable file from this directory will automatically process the 

scene, but there is no way to change default parameter values this way. The windows command 

prompt will open and the algorithm will automatically start, and the window will close 

automatically once processing is finished*** 

17. Once the algorithm is finished, the Windows command prompt will display the processing time and 

the percent of clear-sky pixels for the scene. 

18. The output will be two files inside the original scene folder using the nomenclature: 

SceneID_MTLFmask and SceneID_MTLFmask.hdr. 

19. In ERDAS, use the import data tool to import .HDR to .IMG, it is recommended to save the new 

file as SceneID_Fmask.img removing the “MTL” which I believe is a minor bug in the fmask 

software, but this isn’t critical to do, but keeps naming conventions neat. 

20. If it is desired to view the SceneID_Fmask.img in ERDAS overlaid with the original stacked image, 

then SceneID_fmask.img needs to first be converted from continuous to thematic data type by 
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using the Edit Image Metadata tool under Manage Data tab in ERDAS. This does not need to be 

done prior to running the masking model, and doing so will not cause any errors so long as the 

pixel values are not changed. 
Pixel values are: 

0 -> clear land 1 -> clear water 

2 -> cloud shadow 3 -> snow 

4 -> cloud 

255 -> no data 

To remove clouds, shadows, and snow from imagery, use the ERDAS model “4_apply_fmask.gmd.” The 2 

inputs are the output raster from the fmask algorithm, and the image raster to be masked, which can be 

the raw stacked DNs, radiance, TOA reflectance, or vegetation indices. The output will be the same 

dataset, but with the value of 0 substituted for any pixels identified as cloud, cloud shadow, snow, or no 
data. 

 

Reference 
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